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Scanning Troubleshooting
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Camera Image Not Appearing In Scanning Window
Not seeing an image when attempting to scan? This help document will address several common
causes of this issue and provide solutions.

In some instances, based off of your answers to the questions asked, you will be asked to follow a
new link; worry not! All links will open in a new tab or window and will include navigation back to
this document.

Short on time? Call us (951-739-0186)

Has the GradeCam plugin been installed?

If your GradeCam window looks similar to the one above, you have not yet installed the
GradeCam Plugin. Please select the appropriate link for your operating system: 'Install GradeCam
Plugin for PC' or 'Install GradeCam Plugin for Mac.

Unable to download the plugin? Please contact your district or Site tech department for
further assistance.
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Black or Gray Screen appearing?

If you are encountering a screen similar to this, please proceed to the next step.

Have you selected a camera to scan with?

If your camera is not automatically displaying in the scanning window, you will need to select
Tools > Settings (right below the GradeCam window) and choose the corresponding camera from
the dropdown. Once you have selected the camera, click Done, Return to Scanning.

If you are able to select your camera and you are still not able to see an image, please skip down
to the next step.

On occasion, a preferred camera may not appear in the dropdown. There are several reasons why
your camera may not be appearing:

- The USB cable is not securely connected to your computer. If you are using a Document
Camera, make sure you have the USB cable plugged in and not just the VGA cable.

- Switch USB ports. Be sure to connect to a USB port on the back of a desktop computer, not in
the front. If using a laptop, try another port.
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- Reboot your computer. Depending on the point in time you plugged in your camera, your
computer may not see it.

- Verify your camera works correctly.Try using your camera with another program (i.e. Skype),
but make sure you exit this program before trying to use GradeCam again. If your camera does
not work with another program (i.e. Skype), please contact your District or Tech department for
further assistance.

Still not able to see an image? Please proceed to the next step.

Is this camera being used by another program?

GradeCam can be a bit of a jealous program; if the camera is being used by any other program it
will not show up in the scanning window. Similarly, multiple open tabs or browser windows can
hide a previously open scanning page. In both instances, exiting all programs is the best way to
ensure that the camera is not in use.

Camera still not working?

Perhaps you are not using a GradeCam compatible camera. While GradeCam supports hundreds
of cameras, there are several that will not work with the program. Please look over our Which
Document Cameras Work with GradeCam and Which Web Cameras Work with GradeCam.
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Still having trouble? Call us (951-739-0186).
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My Answer Sheet Is Not Scanning
This document will address common issues than can prevent users from successfully scanning,
which can lead to failed scanning attempts and user frustration.

Short on time? Call us (951-739-0186)

Is the print quality for the answer sheet poor?

Sheets that have been printed using Fast Draft or Low Quality settings, on a printer with low toner,
or sheets that have been through a copier too many times, can often be the root of the problem.
Random ink marks, blurred lines, printer smears and distortion can make it nearly impossible for
GradeCam to scan; examples can be seen in the image above.

Remember: The answer sheet should be clear of extraneous marks and be darkly printed.
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Has this answer sheet been modified?

If you have attempted to modify an answer sheet, say to increase the size of the bubbles or to
include the school's logo at the top, you should always test it to make sure it will work with
Illuminate before handing it out to students. Our sheets have been carefully designed and
calibrated to work with GradeCam; alterations, no matter how small, can have large
consequences.

Never attempt to modify or add content within the black rectangle. Answer sheets (such as
the one above) will not scan!

If the sheets you are using are modified, try testing a non-modified sheet in the same assessment
to determine if the sheets are the root cause of your troubles.

Think: Test First, Scan Test Later.

Do the number of questions on the answer sheet match the number
in the assessment?

If you use default sheets (pre-generated) for all assessments, make sure the sheet will work for
the selected assessment. If there are fewer questions on the answer sheet than the assessment
(eg, 20 on the answer sheet and 25 on the assessment) the sheet will not scan.

Confirm that the total number of questions on the answer sheet equals the total number of
questions in the assessment. This can also help prevent you from scanning answers into the
wrong assessment.
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Does the assessment have versions?

If the assessment is set up with versions, the answer sheet must have a form option included. This
will appear, as depicted above, in the upper lefthand side of the sheet. You can still use an answer
sheet with the form option for non-version assessments, just be sure to have your students bubble
form 1.

You can check to see if the assessment has versions by first selecting the corresponding
assessment, then the Advanced tab> Versions. For tests that do not have multiple versions, only
the master version will appear as a selectable option. If there is a version 2 in this area, the
answer sheets must have the form option in order to scan.
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Is this a lighting issue?

While lighting may seem to be a trivial issue, in the world of GradeCam scanning, lighting can
make all the difference.

Here are three example of where lighting can have a negative effect on scanning:

(1) Too much light or too little light can be a problem (e.g., it creates glare). Turn off half your lights
or shield the scanning area from bright lights or move to a different area.

(2) If a glare is causing problems (e.g., with laminated sheets), try holding something over the
scanning area to block the glare. Bubbles should appear black, not silver or white.

(3) Be sure your scanning area is free of shadows (i.e., don't let a shadow of the camera's neck or
head fall across the page you are trying to scan).
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Is the whole answer sheet viewable within the scanning window?

In order for GradeCam to be able to read the answer sheet, the entire answer key (the black box)
must be viewable within the scanning window.

Is the image blurry in the scanning window?

One way to tell if the image is to blurry is this: If you can't read the student's name or see the
question numbers, the image is either too blurry or to far away from the camera. Try adjusting the
camera's focus and distance to alleviate this issue.

Is the sheet right side up?

Student names and IDs must appear at the top of the page. Either turn the sheet so it appears
right side up on your screen or select Settings (found underneath the scanning window) and
check mark Flip Images.
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Document Cameras: Common Issues
Document cameras are amazing tools for educators and perfect for classrooms. However, there
are several common errors that can prevent these tools from functioning correctly.

Need immediate assistance? Please call our Help Desk (951-739-0186).

Is the plugin installed?

In order for document cameras to work with GradeCam, the GradeCam plugin must be installed. If
you do not to see the camera appearing in the GradeCam window, you may need to install the
plugin.

Check to see if you have the GradeCam plugin installed. Not sure how to do that? Please click this
link "How to check my GradeCam plugin". To view the current version of the plugin, Click Here.

If you need to install the GradeCam plugin, please select the appropriate link based off of your
operating system:"Install GradeCam Plugin for Mac" or "Install GradeCam on a PC".

Having trouble downloading the plugin? Contact your District tech!

Are the camera's drivers installed?

Another common reason why document cameras do not work when attempting to scan is caused
by the camera's unique driver not being installed. In order to scan with a document camera, you
need to have both the GradeCam plugin and the corresponding camera software (ImageMate for
ELMO, A+ for AverMedia, etc.) installed.

Not sure if you have the required software? Check with your school/district tech!

Need to install the camera software? Please click "Install ImageMate for ELMO" or "Install A+ for
AverMedia".
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Is the USB cable plugged in?

Due to most document cameras' multi-functionality, there can be several cables needed in order to
use all features. In order to use the camera to scan with Illuminate, you must have the USB cable
plugged in to both the camera and the computer. The cable will look similar to the image above.
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Is the correct mode selected?

When using document cameras, it is necessary to make sure you are using the proper mode. For
most document cameras, there will be a way to change between the various modes (projector,
camera). Make sure that this has been switched to Camera mode.

Still having trouble? Please call our Help Desk for immediate assistance (951-739-0186).
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Scanning from a File: Common Issues
This help document will address the basic requirements necessary to Process Images from a
File as well as several common issues that can prevent this process from working.

Preparing to Process an Image from a File.

The Process Images from a File feature allows users to scan (using scanners) answer sheets
onto their computer and process these answer sheets using GradeCam. This is an excellent
option for districts and users who have access to a scanner but not to cameras or doc cams.

There are several basic requirements that need to be met in order for this feature to work
correctly:

The only accepted file formats are JPEG, PNG, TIFF, and multi-page TIFF.

All files must be scanned in Grayscale and NOT Black and White.

The scanned images must be saved into their own folder; saving these images into a folder with
word documents, excel files and other image files will result in an error and possibly prevent the
system from processing the images.

All images must be 8.5"x11" (Letter size).

The resolution for each file must be between 150-300 DPI.

Important: Illuminate does not support any type of scanner or copier. Questions regarding
scanner/copier related issues should be directed towards your tech department or district
contact.

Common Issues

Having trouble processing images from a file? Please view the following common issues and
solutions.

Need immediate assistance? Please contact our Help Desk (951-739-0186).
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Is the file Black and White instead of Grayscale?

In order for GradeCam to be able to process an image, it must be saved in Grayscale. The left
hand bubble is an example of a Grayscale file while the right hand bubble is an example of a Black
and White. This can be ascertained by checking the settings of the scanner, zooming in on a
bubble (as done above), or checking the properties of the file.

Note: Black and White images do not have the level of detail GradeCam needs to determine which
answer a student selected.

Is the file saved in an accepted format?

The file must be saved in one of the accepted formats: JPEG, PNG, TIFF, and multi-page TIFF.
PDF files and others will not work with this feature.
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Is the sheet quality poor?

If the sheet has been scanned in poorly, resulting in distortion, faintness, or contrast issues, it is
likely it won't be able to scan. Check all your answer sheets to make sure that they have scanned
in cleanly and properly.

Is the file size legal size (8.5x14)?

GradeCam is not calibrated to work with legal size documents. Please change the size to the
accepted format (Letter size, 8.5x11).

Is the answer sheet the problem?

If the answer sheet has extraneous marks, poorly marked bubbles, disjointed or poorly printed
black outline, or is missing key data (such as student ID), you may also encounter errors when
processing from a file. As you would with a regular answer sheet, make sure that the answer sheet
is within the basic requirements to scan.

Need immediate assistance? Please contact our Help Desk (951-739-0186).

Page 18Assessment Scanning



Find Your GradeCam Version Number
Introduction

In some cases it's useful to know which plugin version is installed on your computer. Find the
section below that applies to your operating system for the specific steps.

PC - Windows XP

Go to the Start menu and select Control Panel.
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There are two views for the Control Panel. If you are using Classic View click
on the Add or Remove Programs button.
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If you are using Category View, click on Add or Remove Programs.
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From the list of currently installed programs, click on the GradeCam Plugin.

Click on the Click here for support information link that appears after you’ve
clicked on the GradeCam Plugin name in the list.

The version number is listed below the publisher information.

PC - Windows Vista
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Go to the start menu and select Control Panel
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There are two view options in the control panel. If you're using the standard
view from the Control Panel Home screen click on Uninstall a program.
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If you're using Classic View, click on Programs and Features.
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Find GradeCam Plugin in the list of installed programs and click once on it to
select it. You should see the product information including version number in
the Details pane at the bottom of this window.
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If the details pane is not visible, click on the Organize menu, select the Layout
submenu and choose Details Pane to make it visible.

PC - Windows 7
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Go to the Start menu and select Control Panel
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There are two view options in the control panel. If you are using View by
Category, click on Uninstall a program under the Programs category
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If you are using View by icons (small or large), click on Programs and
Features
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Find GradeCam Plugin in the list of installed programs and click once on it to
select it. You should see the product information including version number in
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If the details pane is not visible, click on the Organize menu, select the Layout
submenu and choose Details Pane to make it visible.

Mac OS X - 10.4 (Tiger), 10.5 (Leopard), 10.6 (Snow Leopard)

From the desktop, go to the Go menu and select Home to open a new window
with the user’s home directory in it.

Page 32Assessment Scanning



Double click on the Library icon, then the Internet Plug-ins to get to the folder
where the GCPlugin.plugin is stored.

Click on the GCPlugin.plugin to select it, then go to the File menu and choose
Get Info (or press the Command + I keys on the keyboard).
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The version number is on the information window.

Mac OS X - 10.7 (Lion) and 10.8 (Mountain Lion)
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The process to find the GradeCam Plugin in Lion is exactly the same as for
other versions of OS X except for the first step. In Lion, Apple has hidden the
user’s Library folder. To get to it go to Go menu, and press the option key. An
option for Library will appear. Select the Library option to open a new window
with the library in it.
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Scanning
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VIDEO: Scanning 101
The password for all Illuminate videos is illuminate.

If you are unable to see the video below, it is probably due to your district firewall blocking
Vimeo.com. To view this video, please download the zipped file here: https://illuminateed.com/
videos/GradeCam101.zip

Page 37Assessment Scanning

https://illuminateed.com/videos/GradeCam101.zip
https://illuminateed.com/videos/GradeCam101.zip


VIDEO: GradeCam Quick Tips
The password for all Illuminate videos is illuminate.

If you are unable to see the video below, it is probably due to your district firewall blocking
Vimeo.com. To view this video, please download the zipped file here. http://www.illuminateed.com/
videos/GradeCamQuickTips.zip

This video goes over information found in our scanning quick tips document. It helps users
correctly configure their computers and cameras and goes over some common scanning
challenges.
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VIDEO: Process Images from a File (eg. Scanning from a
Fujitsu or other Scanner)
If you are unable to see the video below, it is probably due to your district firewall blocking
Vimeo.com. To view this video, please download the zipped file here. http://www.illuminateed.com/
videos/Sheetfed_Scanner.zip

In this video, we will cover how to use a scanner to import student responses into an assessment.
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Scan Student Responses with GradeCam
You will need a document or web camera for this action.

GradeCam is a fast, easy way to scan student responses and instantly determine their
performance. If you also use the Illuminate Student Information System's GradeBook and Parent
Portal, you will also be able to see student performance there as well.

Where to Start

1. Click Assessments.

2. Under General select List Assessments or select to Create a New Assessment. Please view
"How to Create a New Assessment" for further assistance.

List Assessments

1. Click clear to remove any previous search filters and type the name of the assessment you want
to access.

2. When viewing your assessment list you may click the scan icon to enter the scanning screen,
OR...
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1. Once in your assessment Overview page, select the Administration tab.

2. Click Scan.

First GradeCam Use

If this is the first time you are using GradeCam, Illuminate will prompt you to install the plugin. For
directions on how to do this, click the link that applies to your computer.

Install Plugin for PC

Install GradeCam Plugin for Mac

Pick a Scanning Mode

There are 2 different scanning modes. Whichever mode you pick, you should stick with it for your
entire scanning sessions (i.e., do not jump back and forth between modes during your scanning
session).
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Pick Teacher Mode if you want all students' results to display on the screen as they are scanned.
This will also allow you to click Show which will list the questions a specific student answered
incorrectly.

Note: Some privacy is offered because only the student ID is displayed.

Pick Student Mode if you want each student's scores to display on the screen as they are
scanned. Press Enter on your keyboard after scanning to clear the screen so the next student
who scans will not see how other students performed.
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Scan Answer Document(s)

On your computer screen you should see what your camera "sees" (i.e., if you see yourself on the
screen, it means your document/web camera is pointed at you). When you are ready to scan your
first answer document, you should do the following:

1. IF your camera is not displaying in the scanning window, click the Tools button. This will
provide a link to your Settings select the camera you want to use and other camera settings (e.g.,
to "flip" the camera if the image on your screen shows your answer document upside down based
on how you want to place it). For more information on GradeCam Settings, Click Here.

2. Place your answer document so that the entire black box (as outlined above) appears clearly
(and upright) in the camera window. Since the image is not mirrored, moving the answer
document to your right will move it to the left on the screen, and vice versa. Please view our
Scanning Troubleshooting lessons for more details if you are having trouble.

IF you are scanning in Teacher Mode, you can scan student sheets consecutively after the sheet
is registered by GradeCam (signified by a beep and the addition of the student's score to the list).

IF you are scanning in Student Mode, once the sheet has been registered, press Enter on your
keyboard to clear the screen before the next student scans (thus keeping results confidential).
When finished with your last student, click Teacher Mode and then Yes (as shown above).
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Note that GradeCam also has an Autosave feature that you can opt in/out of when scanning
assessments. If you opt out of using this feature, make sure to press Save & View Results > Save
as Assessment to keep the results. Note: This feature does NOT work with On The Fly
Assessments.

When Finished Scanning

When finished scanning click Save & View Results to save the results. If you do not click this
button, the results will not be saved. It is suggested that users save response every 20-30
minutes.

Note: You can always return to the scan more student response.

Next Steps

If you experience any problems scanning, please see the Scanning Troubleshooting lessons for
additional support. Also, for additional resources on Scanning- See Illuminate U's lesson: U300-
Find, Print and Scan Assessments
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Browser noplugin for GradeCam
This will guide you through the use of noplugin for GradeCam which is a browser based plugin
which will cause GradeCam to run through your Internet browser and will not need any additional
downloads.

Q: Will this affect me if I already have the normal GradeCam plugin installed?

A: Users who still have the normal plugin installed on their computer will not be affected yet until
one of two things happen; 1: NPAPI is disabled on your browser (manually or automatically by
Chrome update), 2: You uninstall your current plugin. You will notice a small change in the
interface of the scan window.

Currently if you have no plugins the install page looks like this:
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With noplugin it will look like this:

You will have the option to install the GradeCam plugin or continue without it. To start the noplugin
version, select the continue without. Keep in mind that since it is a browser based plugin,it is a little
slow to startup. It will then ask for permission to allow or block camera, please choose allow.

If you are having problems getting the camera to communicate with the NoPlugin in Google
Chrome, you may have to clear out the cache for the browser. You can clear the cache for
Chrome by going to Menu > Setting > History > Clear browsing data > Clear cache and plugin
data (beginning of time) > Clear Browsing Data.

Additionally, there is a change on how the different camera settings are handled. Since it is a
browser based plugin, to change the camera you have to change it on the address bar. Once it is
changed, you have to refresh the page to engage the new setting. Beyond these differences, it
has the same functionality as the other regular plugin.

NOTE: The biggest issue with noplugin is that it will not work with ELMO currently. If you
are using ELMOs, you have to use a different browser such as Firefox or Internet Explorer with the
regular plugins until GradeCam comes up with a fix.
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Reconcile an 'Unknown' Student Answer Sheet
This lesson will guide you through assigning a student to their scores if you received 'UNKNOWN'
as their name in the Score Distribution list immediately after scanning.

Where to start

At this point, you have scanned answer documents and are on the 'Save & View Results' page. At
the bottom, where you see a list of your rostered students, you see an 'Unknown' instead of a
student name, to take the first step to reconciling this, click on the word 'UNKNOWN'.
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Reconcile Student Name

The 'Reconcile Student Name' box will appear, now:

1. Type in all (or part of) a student's name to find them in Illuminate.

2. Click 'Search Name'.

3. Search results will populate under 'Search Result', select the bubble which matches with the
student you want to assign these scores to.

4. Select 'Set Name'.

Once 'Set Name' is clicked, the 'Reconcile Student Name' box will disappear and you will see the
student name instead of 'UNKNOWN' and this score will be tied to this student.
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Scan Student Responses Using a Sheet-Fed Scanner
We highly encourage users to "scan" student answer sheets using a webcam or document
camera. Web or document cameras provide students and teachers with immediate assessment
feedback and does not require any additional personnel or time for processing.

However, if your district wishes to use a traditional scanner (e.g., Fujitsu 6130 or Brother MFC
machine) you can use your scanner to scan student answer sheets onto a computer as JPEG,
PNG or TIFF image files in a folder on your computer. You can then use this file folder to process
the images into an assessment.

This lesson will help you process student answer sheets in Illuminate. While we provide you with
some guideline's on how to scan your sheets into a file, we cannot provide technical support for
your sheet-fed scanner. Please consult your scanner's user manual or support center for help
scanning sheets and saving them as one of the supported image types.

Illuminate Permission

In order to Process images from a file, you will need to have the GradeCam Plugin installed.

Install GradeCam Plugin for PC

Install GradeCam Plugin for Mac

You will not be able to complete this lesson/process unless you have the ability to see and

use the "Process images from a file" option in the Tools tab. If you don't see this option,

please contact your district's Illuminate administrator to request this permission.
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Suggested Guidelines for Scanning Sheets

You must use your scanner to scan sheets as JPEG, TIFF, or PNG files into a folder/directory on
your computer or file server. Please consult your scanner's manual or support center for how to
use your scanner.

There are several basic requirements that need to be met in order for this feature to work
correctly:

The only accepted file formats are JPEG, PNG, TIFF, and multi-page TIFF.

All files must be scanned in Grayscale and NOT Black and White.

The scanned images must be saved into their own folder; saving these images into a folder with
Word documents, Excel files and other image files will result in an error and possibly prevent the
system from processing the images.

All images must be scanned at 8.5"x11" (Letter size).

The resolution for each file must be between 150 and 300 DPI.

It is recommended you consider how to best store and access scanned images. This will vary
depending on how your scanner or copier is set up.

Note: GradeCam will process all the images in the file folder you select. Keep all the images of a
particular assessment together in the same folder. DO NOT put images not associated with the
select assessment into this file folder as this may cause an error when processing.

Let's Begin

Once in Illuminate, click Assessments >> List Assessments. This will load the List Assessments
page. Find the assessment you wish to scan student responses into and click on the scan camera
icon on the left or click on the assessment's Title and then click Scan Student Responses on the
following page.
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Note: If you are creating a new assessment, you may not use the sheet fed scanner to scan the
answer key. You may either use a webcam or document camera to scan the answer key, or you
may manually enter the answers.

Click Process images from a file.

Locate File on Your Computer

1. Navigate to the folder on your computer that contains your student's answer sheet images.

The same, single file folder must contain all image files you want GradeCam to process into your
assessment. Make sure you are accessing the right images for your particular assessment!

2. Select a folder. Click OK.
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You might be prompted to verify certain student responses (e.g., a student left some answers
blank or bubbling is unclear). Note these important features:

1. The student ID of the answer sheet in question is displayed at the top of the verification screen.

2. You may change answers as necessary. Click on an empty bubble to fill it, or a filled bubble to
empty it.

3. Click Accept to make any changes take effect.

4. Click Ignore to ignore the message and let the system attempt to re-scan the sheet.
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Proceed to Results

When all files are done processing, click Save and View Results to save the results. Then to
save this as an assessment, select Save as an Assessment.

Next Step

Once you have saved the student responses, you will be able to access the data from within the
Assessment's Overview page.

Having trouble scanning? Please contact your District admin or view our Scanning
Troubleshooting help documents for further assistance.
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Scanning Quick Tips
Use pencil or pen with blue or black ink.

GradeCam is looking for contrast between the filled-in bubble and the blank bubbles. If you use a
pen or pencil that is a light color, such as yellow or red, it will have a hard time scanning. Using
blue or black ink or a pencil work best.

Pencils can cause glare.

Glare causes a big challenge for GradeCam. Pencil marks are reflective and can cause glare that
disrupts the scanning process. If your students are using pencil, make sure that it is not causing
glare so GradeCam can properly scan your assessment.

Check the preview window.

The GradeCam preview window is your view into what GradeCam “sees.” Use it to make sure that
all the bubbles appear dark and in contrast to the rest of the paper. If some of the bubbles appear
silver, white, or anything that is not black, this could be causing problems. Check your light and
focus to try and make all the bubbles black!

Get close, but not too close.

GradeCam uses the black rectangle surrounding the bubble area to figure out where to start
scanning. If your camera is too far away from the paper (or is too zoomed out in the case of
document cameras) it may cause errors scanning. If the camera is too close and part of the
rectangle is cut off, however, GradeCam won’t know where to start reading the bubbles, and may
appear to freeze. Make sure that the whole rectangle is visible in the preview window and you
should be able to scan properly.

Use the right number of bubbles.

Make sure the sheet you’re scanning has at least the same number of bubbles as there are
questions on the assessment. For example, if there are 40 questions on the assessment, there
should be at least 40 bubbles on the assessment. If there are less bubbles on the answer sheet
than the questions on the assessment, GradeCam will not scan the sheet. .

Use pre-slugged answer keys.

Pre-slugged answer keys work much better for scanning. Not only is the student ID bubbled in
correctly, but the student’s name is also listed along with the assessment title. This is really helpful
when you’re looking for a specific answer sheet in a big stack. It also helps prevent errors
scanning an answer sheet to the wrong assessment.

SAVE responses

Make sure to save your scanned student results every 10-15 minutes. This will prevent lost data
and wasted time. Click 'Proceed to Results' to save.

Call Illuminate if you have questions.
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If you’re stuck and getting frustrated, give us a call. Our support staff is here to make sure you
have the help you need to scan successfully.
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Print Answer Sheets
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Print GradeCam Answer Sheets (Pre-Slugged OR Blank)
This lesson details how to print GradeCam answer documents, both Pre-Slugged (Pre-ID) and
Blank.

Caution: Continue to TEST your answer sheets before giving them to students! Using some
of the advanced options it is possible to create sheets that won’t scan under non-perfect
conditions.

NOTE: You can scan a combination of old and new answer documents at the same time,
into the same assessment. The old answer sheets are currently still supported.

Where to Start

1. Click on the Assessments tab.

2. Under GradeCam, select Print Answer Sheets.
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Print Pre-Slugged OR Blank Answer Sheets from the same page:

1. You can print blank or pre-slugged or blank within the same page. Pre-Slugged answer
documents will NOT display the Student ID, this is integrated into the Form Code at the bottom.

2. Use the filters at the top to select the student set of classes you would like to print these answer
documents for.

3. Input the number of questions.

4. Advanced Options:

Zoom- Allows you to make the bubbles bigger or smaller. This is useful when you have 1st
graders taking a 50 question test and they struggle with bubbling.
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One Form Per Page- Allows you to print more than one sheet per page (Blank & Pre-Slugged) if it
“fits”. For example, you have a 5 question sheet and you want to print 4 students to a page to
save trees.

Group by Class- Allows users to print just a list of students. This is useful in cases where you want
to print sheets for your after school student group.

The sheet Header and Footer options allow you to customize what prints out above and below the
sheets. Currently only 6 lines are supported between both the header and footer.

5. Generate- Below you get a preview of the sheets with the option to print them right then and
there with the option to download to PDF. (See Below)

Once generated, you can select Print to print from this browser window, or select Download to
download this batch to a PDF.

Caution: Continue to TEST your answer sheets before giving them to students! Using some
of the advanced options it is possible to create sheets that won’t scan under non-perfect
conditions.

Page 59Assessment Scanning



What's new about these sheets compared to the older ones:

• The new sheets are more accurate.
• Blank bubbles now display x’s so students know not to bubble them.
• The student ID is now encoded as part of the form code. Form Identifier- Think of this as a

GradeCam specific QR Code.
• We can support more than 5 versions.
• We can support 6 bubbles.
• We can support a test of only True / False questions.
• The Student ID is outside of the box when doing non-preslugged. This is so students' text

doesn’t conflict with scanning.
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Print Answer Sheets From Within An Assessment or Print
Multiple Version Answer Sheets for Gradecam
This lesson will cover how to print blank and/or pre-slugged answer sheets for a multiple version
assessment for use with GradeCam in Illuminate Education.

Where to Start

1. Click Assessments.

2. Under General, click List Assessments.

When your assessment opens, you will automatically be on the Overview tab. If you have moved
from here to visit other sub-tabs, simply return here by clicking the Overview tab. From this menu,
select Administration and Print Answer Sheets.

For assessments with multiple versions, you must print answer sheets from this location (as
opposed to the GradeCam tab elsewhere in the system) to print answer documents that will
display the form numbers you need.

You may opt to print blank answer sheets (i.e., with no student names) and/or pre-slugged (pre-
ID with one student's name and GradeCam ID per sheet) answer sheets. Simply click on the link
that applies to your needs.
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If You Chose "Blank"

If you clicked the "Blank" link you will go straight to an image of your blank answer sheet. Select
Generate, then Print or Download (For a PDF version).
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If You Chose "Pre-Slugged"

If you clicked the "Pre-Slugged" link you will need to tell the system which group of student names
it should use.

1. Select from the options provided which Site, Session, Department, User, Course and Section
you would like to use for your pre-slugged answer sheets.

2. Click on the Generate button to generate your answer sheet. A preview will populate below this
that shows you a sample of what your answer sheets will look like (if you only see 5 students, don't
worry; this is just a sample, and continuing will allow you to print for all your students).

3. Select Print or Download (If you want them in a PDF file).

Next Steps

After your sheets print, you might be interested in seeing the "Scan Student Responses with
GradeCam" lesson for further assistance.
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Print Answer Sheet Options
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Print Multiple Answer Sheets per Page
If you want to print blank answer sheets (meaning any students can use them by simply bubbling
in their ID numbers and writing their names above the boxes, or you can choose do this for them
before class starts) so that multiple answer documents print on one page (meaning that you can
print a sheet of 6, for example, cut it into sixths, and have students use these for scanning in order
to save paper), Illuminate has prepared some for you based on popular test sizes.

Where to Start

Click on the Assessments tab.

Under the GradeCam section, you have a varied options:

1. Click Print Multiple Answer Sheets per Page (10 Questions) if you want to squeeze multiple
10-question answer sheets on a single page (to cut up).

2. Click Print Multiple Answer Sheets per Page (25 Questions) if you want to squeeze multiple
25-question answer sheets on a single page (to cut up).

3. Click Print Multiple Answer Sheets per Page (50 Questions) if you want to squeeze multiple
50-question answer sheets on a single page (to cut up).
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Next Steps

If you want to print pre-slugged answer sheets (meaning that they already feature each
student's GradeCam ID number and name) with multiple answer sheets on the same page, or if
you want to print blank answer sheets with a different number of questions or ID number
columns with multiple answer sheets on the same page, see the "Print Multiple Answer Sheets
per Page that You Customize Yourself (Advanced)" lesson for guidance.
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Print Multiple Answer Sheets per Page that You Customize
Yourself (Advanced)
This lesson will walk you through one method of customizing your answer sheet.

Want to use pre-created and supported Multiple Answer Sheets per Page? Click Here

Warning: When customizing answer sheets, there is a risk of changing the size, aspect ratio, or
image quality of an answer sheet. These answer sheets have been carefully calibrated to work
with GradeCam and any changes can render the sheet unreadable by the program. Any
customized sheet must be tested thoroughly before students use the answer sheet. While
users can customize answer sheets, our support team may not be able to assist with issue arising
from this process.

Customize at your own risk!

Where to Start

1. Click on the Assessments tab in the navigation bar.

2. Under GradeCam, click on Print Answer Sheets.
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Indicate Number of Questions

Keep in mind that you can use an answer sheet with extra spaces for a shorter test (for
example, you could print answer sheets for 30 question tests and use them for tests with only 28
questions - Illuminate will simply ignore any extra question numbers when you scan, based on the
number of questions on your answer key). Since the steps you are doing now can take
approximately 10-15 minutes per page, you might want to create documents that you can use for
many tests to save you time in the future.

1. Enter the Number of Questions you would like to appear on each student's answer sheet. You
might want to look at the samples (via links at the top of this lesson) for an indication of how many
sheets will fit on one page. Keep in mind that this number will rely on how many digits your
GradeCam ID numbers contain (e.g., districts with 9 digits cannot fit as many answer sheets on a
page as districts opting to use 4 digit GradeCam ID numbers). Optional- Add Student Name Line/
Additional Notes.

2. Click Generate to see an answer sheet image.
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Option 1: Traditional Cut and Paste

You now have two options: traditional (hard copy) cut and paste, or making the sheets on
your computer.

If you plan to use scissors and tape or glue to create your sheets (that can then be
photocopied to use again and again), simply:

1. Click Print. Print as many copies as you need.

2. Cut out the boxes (making sure that you do not cut into the boxes' black outlines).

3. Arrange and affix the boxes on another sheet of paper, and you are done. You may even add
other images and/or words to the sheets, as long as you do not get these inside the scanning
boxes.
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Option 2: Computer Cut and Paste

If you plan to keep using your computer to create your sheets (that can then be printed to
use again and again), simply follow the remaining steps:

1. Now that you see one answer sheet on your screen, be sure that the image is clear (like the
above image). If it is not, try increasing the size of your screen. For example, on a PC you can
press the "Ctrl" button and the "+" (plus) button simultaneously on your keyboard to increase the
screen size (just hit Ctrl and "-" when you want to shrink it again). On a Mac you can do the same
thing, only use the Command key rather than a Ctrl key.

2. Be sure the box's entire black outline is visible on your screen. Scroll up and down (or resize
your screen) if necessary so that it fits.

3. Next, capture a screen shot of the image. On a PC keyboard, simply press Ctrl and Shift and
Prnt Scrn (usually in the upper-right corner of your keyboard) simultaneously. On a Mac
keyboard, simply press Command and Shift and 3 simultaneously (this will add a screen shot file
to your computer Desktop); or press Command and Shift and 4 simultaneously on a Mac
keyboard, then hold the left click on your mouse down and drag to select the area you want (this
will also add a screen shot file to your computer Desktop, but only of the area you selected).
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Do not print to PDF and do not try to then capture a screen shot from the PDF. Remember: if
your entire answer sheet is not showing on your screen, simply press change your screen size: on
a PC you can press the "Ctrl" button and the "+" (plus) button simultaneously on your keyboard to
increase the screen size (just hit Ctrl and "-" when you want to shrink it again), and on a Mac you
can do the same thing, only use the Command key rather than a Ctrl key.

1. Open up Microsoft Word (or use another program you know will allow you to manipulate
images). We will use Word 2007 for the remaining instructions, so please note that the
version of Word you use could slightly alter the look of your screen (and thus the location
and navigation for "clicking" and more).

2. Click the round Office button (very upper-left corner of your screen) and select New to create a
new answer document (or press Ctrl and N simultaneously on a PC keyboard as a shortcut, or do
the same thing on a Mac but use the Command key rather than a Ctrl key).

3. Click on the image of your new document (anywhere inside the page). Nothing will happen; this
merely sets you up for the next step.

4. If you are using a PC, click Paste from your Home tab and then select Paste (or press Ctrl and
V simultaneously on your PC keyboard as a shortcut) to paste the answer document image that
you copied earlier. If you are using a Mac, either drag the image file (that you saved to your
Desktop earlier) onto the page, or click Insert from your Home tab (circled in the image above in
purple) and then navigate to find the Desktop file and consent to insert it into your document.
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1. Click Crop.

2. Hover over one of the short black lines that now surrounds your image, click to "grab" one line
at a time and (while still holding down your left mouse click) move the lines inward to crop off parts
of the screen shot you don't want. Be sure that you don't remove any portion of the box's black
outline. Repeat this with all sides of the image as necessary.

3. Click Text Wrapping and select In Front of Text. Notice that you are now able to move your
image around the page.

4. Click the Size menu, find the Scale area of the window that appears, and change the height to
100% (this should cause the width to change to 100% as well, because Lock aspect ratio should
remain checked), then click OK. This will cause your image to resize to the same size as it would
ordinarily print.

5. Now click on your answer document that you want to copy (to repeat elsewhere on the page).
From your Home tab, click Copy (or press Ctrl and C simultaneously on your PC keyboard as a
shortcut, or do the same thing on a Mac but use the Command key rather than a Ctrl key).

6. Now click anywhere on your page; from your Home tab, click Paste and then select Paste (or
press Ctrl and V simultaneously on your PC keyboard as a shortcut, or do the same thing on a
Mac but use the Command key rather than a Ctrl key) to paste the answer document image that
you copied earlier.

7. Continue to paste as many answer document images as you need and drag them to place them
anywhere on the page. You can fit as many answer sheets as you want (as long as they don't
overlap and aren't resized above or below 100% in scale).

8. When you are finished, click the round Office button (very upper-left corner of your screen) and
select Save to save your document for future use (or press Ctrl and S simultaneously on a PC
keyboard as a shortcut, or do the same thing on a Mac but use the Command key rather than a
Ctrl key).
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Next Steps

IMPORTANT: Test scan what you create before using it with students and/or before creating
others to be sure the size (and other aspects) is appropriate.

If you saved your document, you can open the file and print from it anytime you want to give
another quiz, as long as the quiz doesn't have more question numbers.

Warning: When customizing answer sheets, there is a risk changing the size, aspect ratio, or
image quality of an answer sheet. These answer sheets have been carefully calibrated to work
with GradeCam. Any customized sheet must be tested before live use.

Customize at your own risk!
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Having Trouble Printing Answer Sheets for GradeCam
If you are trying to print GradeCam answer sheets in Illuminate DnA and are having trouble, this
lesson will help you troubleshoot the issue.

Where to Start

You should see one of the following lessons (based on your needs) and complete as many steps
as possible:

Print GradeCam Answer Sheets (Pre-Slugged OR Blank)
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If Nothing Happens When You Click Print

When you select Generate at this point, your answer sheets should populate at the bottom of the
page and show you a sample of what your answer sheets will look like. If this doesn't happen, one
of two issues is probably occurring:

1) You have not entered all of the required information. Have you used all of the above input
controls to tell the system:

a) For which Section are you printing sheets?

b) What is the Number of Questions for your sheets?
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Print

2) Once you select Download, if you do not see an image like the above image pop up in PDF
format, it could be that you are using a pop-up blocker on your system. A bar may have shown up
at the bottom of your screen asking you to keep or discard the download. Select Keep. On some
systems, you can bypass your pop-up blocker by holding down the Shift button while clicking.
However, you can just opt to turn off your pop-up blocker by following the steps below.
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The exact steps will depend on your browser, but here is an example of how this is done in
Internet Explorer:

- Click Tools.

- Select Pop-up Blocker.

- Select Turn Off Pop-up Blocker.

Next Steps

After your sheets print, you might be interested in seeing the "Scan Student Responses with
GradeCam" lesson for assistance.
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Teacher Setup
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GradeCam Teacher Cheat Sheet
This document should be printed out and placed next to each teacher's scan station.

Click this link to download the PDF version of this sheet! (https://illuminateed.com/HelpHandouts/
TipsForSuccessfulScanning.pdf)
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Install GradeCam Plugin for PC
GradeCam has developed a plugin which increases scanning speed and accuracy. This lesson
will walk you through the installation steps, which you will only have to complete once.

Do you have an older version of the GradeCam plugin and want to update? Click Here!

Note: GradeCam is designed to be installed without needing administrator permissions on a
computer. However, some districts have deployed the GradeCam plugin as an administrator. If
this is the case in your district, contact your IT department for help with the software installation.

Do you want to information about deploying the GradeCam plugin on multiple PCs at the same
time? Check out our help document designed for IT professionals Here.

Where to Start

1. Click Assessments.

2. Under General select List Assessments.

1. When viewing your assessment list you may click the scan icon to enter the scanning screen,
or...

2. You may opt to open the assessment by clicking on its name and then clicking Scan Student
Answer Sheets on the screen that appears thereafter.
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You will be prompted to to Install the GradeCam Plugin via the scanning window. Click on the
Airplane to be direct to the GradeCam plugin downloads page.

Downloading the Plugin

1. Click Downloads to start downloading the GradeCam Plugin.

2. On most browsers, the download will appear in the bottom lefthand corner. Once the download
is finished, Open the download by double-clicking on it.

When opening the GradeCam Plugin, a security pop-up may appear. Select Run to start the
installation process.
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Once the GradeCam plugin is finished installing, click the GradeCam All Done! pop-up and
restart your browser.

Once your browser has restarted, you will be able to re-log in to Illuminate and begin scanning.
Please view our "Scan Student Responses with GradeCam" help document if you are unsure of
how to start scanning.

Having trouble scanning? Please view our "Scanning Troubleshooting" help documents for
further assistance.
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Install GradeCam Plugin for Mac
This lesson will walk you through the installation steps on a Mac.

Do you have an older version of the GradeCam plugin and want to update? Click Here!

Install GradeCam Plugin for Mac-Where to Start

1. Click Assessments.

2. Under General, click Create a New Assessment.

Create a New Assessment

Select 'On The Fly' to be taken directly to the scanning screen (1), enter the number of questions
for your assessment (2), click OK (3).
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Download the Plugin

When you arrive at the scanning screen, you will see above prompt in the scanning window. Click
on Install the GradeCam Plugin. This will redirect you to the GradeCam downloads page. Click
Download to start downloading the plugin.
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You will see the plugin download in the bottom left corner of your screen.

Double click the plugin download and the GradeCam installer folder will be placed on your
desktop. Open the folder and double click the Install icon.
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A security warning screen will appear. Click Open to start the installation.

A message will appear that the plugin was successfully installed. You will need to restart your
browser before attempting to scan.

Having trouble downloading and installing the GradeCam plugin? Please contact your district
administrator to receive further assistance.

Next Steps

Try scanning again. Use the "Scan Student Responses with GradeCam" lesson if needed.

If you are still unable to scan, please view our "Scanning Troubleshooting" help document for
further assistance.
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Scanning with ELMO or AVerMedia Cameras
This lesson only applies to people with ELMO or AVerMedia document cameras. The GradeCam
plugin will work with most standard USB cameras without any additional setup. If you have a
normal camera, please check out our Install GradeCam Plugin for PC or Install GradeCam Plugin
for Mac.

Not all models of the ELMO or AVerMedia cameras are supported. Click Here to find out if your
camera will work with GradeCam.

ELMO Cameras

You need three things to use your ELMO camera with GradeCam:

1. The GradeCam ELMO Plugin
2. ImageMate version 3.02 (PC) or 3 (Mac)
3. A USB cable connecting your ELMO and your computer

1. The GradeCam ELMO Plugin

You can download the latest version of the GradeCam ELMO plugin on the Illuminate GradeCam
downloads page here: https://www.illuminateed.com/downloads/gradecam.html. Scroll down to the
section titled ELMO Plugins and download the version designed for your operating system.

2. ImageMate Version 3

ImageMate 3 works with ELMO TT-12 and TT-02 cameras

• PC - http://www.elmousa.com/sites/default/files/ImageMate3.02_Win.zip
• Mac - http://www.elmousa.com/sites/default/files/ImageMate3_Mac.zip
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3. USB Cable

You must have the USB cable connecting your ELMO camera to your computer. Depending on
your setup, you may also have a VGA cable connected from your ELMO to your computer or your
projector, but the USB cable is required for GradeCam to be able to process images.

What next?

Once you have everything installed and your ELMO connected to your computer via USB, you
should see an image

If GradCam is still not working, check to make sure there aren't any other programs, like Image
Mate, using the camera. Only one program can use your camera at a given time. Please close all
programs or browser tabs except for the window you're scanning in to make sure nothing else is
using the camera.

If you're still having problems, give our helpdesk or your district admin a call.

AVerMedia Cameras

The standard version of the GradeCam plugin (Install Plugin for PC /Install GradeCam Plugin
for Mac) works with AVerMedia cameras, however you'll still need to have the latest version of
AVerMedia's A+ software suite. Go to AVer's support site, select your camera, and download the
A+ software.

Need More Help?

If you're having trouble, check out the "Scan Student Responses with GradeCam" lesson or the
"Scanning Troubleshooting" help document or contact your district admin or our help desk for
further assistance.
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Unable to install Gradecam on a Mac - 'GradeCam is from an
unidentified developer' error during installation
This lesson will guide you through the process of overriding Apple's Gatekeeper program to install
the GradeCam plugin for Mac.

What is Gatekeeper?

Some apps downloaded and installed from the Internet could adversely affect your Mac.
Gatekeeper helps protect your Mac from such apps. Read this article to learn about Gatekeeper
and its options.

Gatekeeper is a new feature in Mountain Lion and OS X Lion v10.7.5 that builds on OS X's
existing malware checks to help protect your Mac from malware and misbehaving apps
downloaded from the Internet.

The safest and most reliable place to download and install apps is via the Mac App Store. Apple
reviews each app before it's accepted by the store, and if there's ever a problem with an app,
Apple can quickly remove it from the store.

For apps that are downloaded from places other than the Mac App Store, developers can get a
unique Developer ID from Apple and use it to digitally sign their apps. The Developer ID allows
Gatekeeper to block apps created by malware developers and verify that apps haven't been
tampered with since they were signed. If an app was developed by an unknown developer—one
with no Developer ID—or tampered with, Gatekeeper can block the app from being installed.

GradeCam does not have a Developer ID, nor do they plan on getting one. That means, if
you have Gatekeeper set up to only allow you to download applications from the "Mac App
Store and identified developers" or "Mac App Store" you may have trouble installing the
plugin. Please see the steps below to temporarily or permanently override Gatekeeper to
allow you to install the GradeCam plugin.
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Where to start

Gatekeeper options are found in Apple menu > System Preferences > Security & Privacy >
General tab under the header "Allow applications downloaded from:"
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Temporarily overriding Gatekeeper to install the GradeCam plugin

If you have GateKeeper configured to only allow installation from the "Mac App Store and
identified developers" the operating system will prompt you with a message like the one above
when you try to install the GradeCam plugin.

1. Click on the "OK" button to dismiss the warning. The plugin will not be installed.
2. Right-click (or hold the control button on your keyboard while clicking the mouse) on the

"Install the GradeCam Plugin.app" icon to bring up a contextual menu.
3. Choose "Open" from the contextual menu. This will pop up a modified version of the

previous warning with two options instead of one.
4. Click on the "Open" button to install the GradeCam plugin.
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Using this option, the next time you try to install an unsigned program, Gatekeeper will prevent you
from completing the installation. If you want to permanently change your settings, read on!

Permanently overriding Gatekeeper to install the GradeCam plugin
(and all other unsigned software)

To permanently change Gatekeeper's settings, follow these steps:

1. Open the System Preferences program by clicking on the Apple Menu and selecting
"System Preferences".

2. Click on the Security & Privacy preference pane.
3. Click on the lock at the bottom of the window and enter your password to enable changes

to these preferences
4. In the "Allow applications downloaded from:" section, select "Anywhere."
5. The system will prompt you that "Choosing 'Anywhere' makes your Mac less secure." Click

"Allow From Anywhere" to make the change. You will now be able to install unsigned
programs.

Next Step

Try scanning again. Use the "Scan Student Responses with GradeCam" lesson if needed.

If you are still unable to scan, please view our "Scanning Troubleshooting" help document for
further assistance.
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Install GradeCam Plugin for Mac OS X v10.4 (Tiger)
If you have Mac OS X v10.4 Tiger and your computer can handle it, we strongly recommend you
upgrade to Mac OS X v10.5 or v10.6. If there is no way you can upgrade, proceed to the next
step.

Where to start

If you MUST use Mac OS X v10.4 Tiger Operating System on your Mac, download the
GradeCam's old 1.1.4 plugin available at https://www.illuminateed.com/downloads/
gcplugin1.1.4.dmg. This will save in your Downloads folder or on your desktop, depending on
how your computer is configured.

You will see the plugin saved on your desktop or in your Downloads folder. (1) Double click to
unzip the plugin. (2) Double click the Install icon. (3) A warning screen will appear. Click Open.
(4) A message will appear that the plugin was successfully installed. Restart your internet

browser if it is open.
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Any time you scan in Illuminate, you will be prompted to upgrade your plugin. Do not do this.

Click Okay. You will be redirected to a new page. Close this page, ignoring Click here to start
your download. Continue scanning as you normally would.

Next Step

Try scanning again. Use the "Scan Student Responses with GradeCam" lesson if needed.

If you are still unable to scan, please view our "Scanning Troubleshooting" help document for
further assistance.
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GradeCam Settings
This lesson will describe the various Settings available for use when scanning with GradeCam.

Having trouble scanning? Please view our "Scanning Troubleshooting" help documents for
further assistance.

Where to start

Go to Assessments > List Assessments and select an assessment from the list. Once in the
assessment, select to Scan Student Responses. This will load the GradeCam scanning page
and scanning window. Under the scanning window, click Tools > Settings.

GradeCam Settings

1. Selected Camera

Allows you to pick a particular camera connected to your system that you wish to use to scan. Be
sure to plug the camera in before opening your web browser.
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2. Flip Image

Allows you to flip your camera image 180 degrees. The sheets should be right side up (not upside
down) when viewed in the GradeCam window. Adjust accordingly.

3. Prompt me for unexpected blanks and/or multiples

Allows you to control whether or not GradeCam will pop-up unexpected answers (blanks and
multiples). Unchecking this setting will decrease the number of times this pop-up will appear, since
it will no longer prompt you for unexpected blanks or multiples.

This setting is useful when scanning results for younger students who may not have filled out
every question and for test where students have bubbled in answers using pen (since erroneously
marked answer cannot be removed). With this setting on, GradeCam will look at your answer key
to determine the number of filled in bubbles for each correct answer and compare to the selected
answers on the student's answer sheet. If the answer is blank or if the multiplicity is higher than
expected, GradeCam will prompt you. For example, if the correct answer is A, but a student as
marked AE, the multiplicity of the correct answer is 1 and the student marked answer is 2. Since
the multiplicity is higher than expected, the GradeCam prompt will appear.

Click Save Settings once changes have been made.

Advanced Settings

Click Advanced to see more ways in which you can control scanning.

1. GradeCam should "think" about marks for no more than

This controls the maximum time GradeCam will spend trying solve problems it encounters. When
GradeCam suspects there could be an issue with bubbling, it will try to improve the accuracy for
no longer than the set amount of seconds. If after this amount of time GradeCam cannot
confidently and accurately read the form, it will pop up the dialog box, prompting you to intervene
and "help" it figure out the questionable bubbles. If GradeCam is able to read all bubbled answers
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within this amount of time, it will scan as soon as possible and no pop-up prompt will appear. If
you want to use standard/default time, select 3 Seconds.

2. My trust level in GradeCam's ability to resolve issues is

This controls the maximum predicted error probability with which GradeCam will determine which
answers are bubbled (in other words, its sensitivity to error). This impacts the frequency with which
the pop-up window can appear (prompting you to indicate which answers to use when GradeCam
can't determine 1 or more bubbled answers). Thus, the smaller the chance of error, the more
frequently the pop-up prompt can appear. If you want to use standard/default sensitivity, select
.001 - Moderate - Normal Popup Activity

TIP: Once you are assured of GradeCam's accuracy, you can adjust the default settings to help
improve scanning speed.

Settings stored in the user's account vs. settings stored on each
computer

The following settings are saved in the user's login account. This means they will be available from
whichever computer that you log into with your user account. The saved settings are:

General tab

Prompt me for unexpected blanks and/or multiples

Advanced tab

GradeCam should "think" about the marks for no more than:

My trust level in GradeCam's ability to resolve issues is:

The following settings could vary depending on which computer a user was logged in to so we
have decided to still store them as cookies. The settings stored cookies are:

General tab

Selected Camera

Flip Image

When finished making any Advanced scanning changes, click Save, back to General Settings.
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Next Steps

Once you are ready to start scanning, you might want to see the "Scan Student Responses with
GradeCam" lesson for guidance.

Having trouble scanning? Please view our "Scanning Troubleshooting" help documents for
further assistance.
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District Implementation Setup
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GradeCam Plugin Installation Information for IT Departments
We've created this help document to help IT techs prepare their district or site for the GradeCam
plugin installation. If you are not a district or site tech, you may find one of the other installation
articles more helpful.

Introduction

There are three ways to install the PC GradeCam plugin:

1. Installation on a per-user basis (standard method)
2. Installation on a per-computer basis
3. Remote installation on a per-computer basis using Group Policy, etc.

There are two ways to install the Mac GradeCam plugin:

1. Installation on a per-user basis (using the standard installer)
2. Installation on a per-computer basis

PC installation on a per-user basis (standard method)

When a user downloads the GradeCam plugin from the Illuminate website, they get an installer for
a per-user installation. Since this method of installation does not install the plugin for all users, it
doesn't require the user to be a local administrator. This can be a good thing for districts that don't
allow users to install software as the user is able to install the latest GradeCam plugin on an as-
needed basis. Also, if there is a new version of the plugin released, the user can run the update
themselves.

As part of the installation process, the installer will remove the older version of the plugin before
the new plugin is installed. However, if the previous version of GradeCam was installed on a Per-
Computer basis, the installer will not be able to remove it unless that user has administrator rights.
This results in two versions of the plugin which can conflict with each other. Make sure that only
one version of the plugin is installed at any given time.

One of the downsides of a per-user installation is that the software is only installed for the user
who installs it. This can be confusing for users on a shared computer as each user must download
and install the plugin for their user account.

If your district uses an imaging program like Deep Freeze, which restores the computer to a clean
state after each reboot, the per-user installation can be frustrating for users who must reinstall the
plugin after each reboot as well. In this case as well as the shared computer case it would be
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better to use an installation method other than the per-user installation to prevent confusion or
frustration.

To download the per-user installation, you can click on the "Install the GradeCam Plugin" link from
the scanning window on a computer that doesn't have GradeCam installed, or you can go to the
Illuminate downloads page and download the per-user installer.

PC installation on a per-computer basis

This installation type installs the GradeCam plugin for all users on a computer. It requires
administrator privileges to complete the installation and is only available from the downloads page.

This type of installation works well in multi-user environments, when computers are deployed from
an image or where it is feasible for an administrator to perform the installation on every computer.

This type of installation can cause problems because it requires an administrator to install or
remove the GradeCam plugin. If the GradeCam plugin is updated, the user will not be able to
update their plugin. Instead the administrator will have to manually update each computer, or push
out a new image with the updated plugin.

Please note: Please note: Illuminate will not force users to update plugin without providing
adequate notice to our district contacts via our GradeCam Updates email list. Click here
(http://eepurl.com/qE_Kz) to add your email address that mailing list so you can stay in the loop.

PC remote installation on a per-computer basis using Group
Policy,etc.

This installation type is almost identical to the installation on a per-computer basis. As such, it has
the same limitations The only difference is the way the file is deployed. Instead of a standard .exe
file, the file is in .msi format to allow easy deployment using whichever tool the district uses for
software management.

You can download the per-computer admin plugin in .msi format from the downloads page

Mac per-user installation

The standard Mac installer installs the GCPlugin.plugin file in the ~/Library/Internet Plug-Ins/
folder. As this is user-specific folder, only the user who has run the installer will have access to the
GradeCam plugin. The user will not need his password to perform this installation.

Mac per-computer installation

To install the plugin for all users on a Mac computer, the GCPlugin.plugin file needs to be moved
from ~/Library/Internet Plug-Ins/ to /Library/Internet Plug-Ins/. You will need to authenticate as an
administrator to move the file into this system-controlled folder. We do not provide a package
installer that will move GCPlugin.plugin to the correct location for deployment with Apple Remote
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Desktop. However, you can create your own package installer with PackageMaker (included in
XCode). You can find more information at the following site (http://s.sudre.free.fr/Stuff/
PackageMaker_Howto.html) or by searching google for the terms “using PackageMaker

Page 102Assessment Scanning

http://s.sudre.free.fr/Stuff/PackageMaker_Howto.html
http://s.sudre.free.fr/Stuff/PackageMaker_Howto.html


Scanning Implementation Setup
This document is intended for new Districts implementing GradeCam for scanning.

This help document will guide you through the initial setup and necessary requirements, while
provided helpful tips on ensuring successful scanning for teachers and users.

Did YOU plan before you scanned?

Making GradeCam Successful For Your Teachers

GradeCam is an easy to use, powerful feedback tool for teachers. It is designed to work with a
camera right from a teacher’s desk. We strongly recommend and encourage every computer that
is going to use GradeCam to be tested. Districts who test teacher’s hardware before scanning are
successful.

Since GradeCam is putting a video image in a web browser, newer machines with faster
processors, more memory, and new browsers will scan much faster than older machines with
older browsers, slow processors, and limited memory (RAM).

System Requirements

Depicted above are the recommended and minimum system requirements necessary to use
GradeCam. While computers that fall into the minimum system requirements will work, users will
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experience longer scan times, increased camera sensitivity to environmental factors (lighting,
camera focus, etc.), and will push their computer's processing power.

When possible, update! Updating will improve the overall GradeCam experience for all users
involved.

Notes on GradeCam Compatibility:

We strongly recommend thoroughly testing every computer that will use GradeCam for scanning
assessments. Districts who have tested all of their hardware before scanning have been
successful implementing Illuminate and GradeCam for scanning in their district. Since GradeCam
is putting a video image in a web browser, the newer computers with faster processors, more
memory, and new browsers will scan much faster than older computers with older browsers, slow
processors, and limited memory.

Mac OS X 10.4 (Tiger) and GradeCam:

GradeCam currently works with Mac OS X 10.4, but with a much older version of the GradeCam
plugin. We strongly recommend upgrading to 10.5 for PPC computers and 10.6+ for Intel
computers.

District Preparation Checklist

When preparing to implement GradeCam, it is necessary to make sure that a plan has been
created at the District level to ensure a successful execution of the GradeCam rollout.

Consider the following checklist:

• Who will install the plugin on each teacher’s computer?
• Do you plan to mass install the plugin?
• Is the most current browser installed on each computer?
• Who will test teachers scanning setup before scanning a live assessment?
• What environmental issues (lighting, glare, camera setup, etc) will impact your teachers?
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• How will teachers get trained? What is the training plan?
• This is a technology rollout. How will the IT team be involved?
• Do you plan to purchase cameras? Which camera is the best solution for your staff?
• What can be learned from other tech implementations? What worked, what was

problematic?
• Become a GradeCam expert. How does scanning work? What are the potential issues

teachers will experience? Who is the district GradeCam expert(s)?
• When do you expect to begin scanning? Have you given enough time to prep for

scanning?

Site Preparation Checklist

In addition to a District GradeCam rollout plan, it is important to make sure that a plan has been
created at the site level as well.

Consider the following checklist:

• Who will install the plugin on each teacher’s computer?
• Is the most current browser installed on each computer?
• Do you have a tech at each site? How will they ensure teacher’s can scan?
• What environmental issues (lighting, glare, camera setup, etc) will impact your teachers?
• Who will be your site expert to assist teachers when their hardware has issues?
• Where are the backup scan stations (clean, dedicated computer and good camera) so

teachers have a place to scan if their setup has an issue?
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Teacher Preparation Checklist

Equally as important as having a District and Site plan is the Teacher plan; well prepared teachers
are the key to a successful GradeCam Implementation.

Consider the following checklist:

• Have teachers tested their setup before scanning a live assessment?
• Does your camera, computer and browser work well?
• Is the most current browser installed on each computer?
• Can you scan quickly and reliably?
• What environmental issues (lighting, glare, camera setup, etc) will impact scanning?
• Do not experiment with sheet design on live assessments. Think: Test first, give tests

later.

Next Step

We have extensive help documentation, for example, to mass install the plugin, print answer
sheets, troubleshoot scanning issues, scan using a scanner and much more. Please check these
lessons out (Click Here).

As you are developing your GradeCam plans, please consult closely with your Implementation
Manager.
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Which Document Cameras Work with GradeCam?
Before purchasing a new camera or using your existing camera, it is best to test your options to
see which camera solution works best for you.

Which Document Cameras Work with GradeCam?

Visit http://www.gradecam.com/cameras/ for a list of document cameras that work with
GradeCam, with notes on their compatibility.

Options Information Directly from GradeCam

Having Trouble Scanning?

See the "Scanning Troubleshooting" lesson for more details.

Page 107Assessment Scanning

http://www.gradecam.com/cameras/
http://illuminate.screenstepslive.com/s/dna_help_manual/m/4830/c/20841


Which Web Cameras Work with GradeCam?
Before purchasing a new camera or using your existing camera, it is best to test your options to
see which camera solution works best for you.

How do I know if a web camera will work?

1. The litmus test is, "Can you Skype with it?" Any camera you can use to Skype can be used with
GradeCam.

2. The camera must connect to the computer via USB; VGA connectors do not work.

3. Do not run your camera software at the same time you are running GradeCam. After choosing
your camera, close the browser and reopen to allow GradeCam to recognize the change. See the
"Scanning" for further assistance with scanning.

4. Test, test, test.

Options

Below are a sample of camera options that have been tested by schools. This is not an
exhaustive list. There are many, many cameras that work with GradeCam. The list includes the
pros and cons schools have expressed.

$8 Camera (this can sometimes be found elsewhere for $6-$7)

http://www.amazon.com/5-0-Megapixel-USB-Camera-Webcam/dp/B0019WF4FE/
ref=sr_1_32?ie=UTF8&m=A3V6BK4D0HKA8F&s=pc&qid=1283962607&sr=1-32 (search on
Amazon for: 5.0MP USB PC Camera Webcam w/ Mic.)

Pros: Cost, Plug 'N Play
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Cons: No stand, little testing

$39 HUE HD Webcam

http://www.huehd.com/products/

Pros: Cost, small foot print.

Cons: Requires driver install (not 'Plug n Play')

$89 iPevo Ziggy

http://www.ipevo.com/prods/IPEVO_Ziggi_USB_Document_Camera

Pros: Document camera, small footprint, auto focus, glare shade

Cons: Cost

$219 HoverCam T3 Document Camera

http://www.thehovercam.com/10-hovercam-document-camera-scanner-x300.html (while not a web
camera, we have heard great feedback from schools about these cameras and thought they were
worth mentioning in this list).

Pros: Document camera, auto focus, 'plug n play', easy to use, sharp images.

Cons: Cost

Sharpat Scan Kit

http://www.sharpatkits.com (the Sharpat Scan Kit™, shown in image above, was developed for
schools as a user-friendly bubble test scanning device that works with GradeCam and Illuminate
DnA; pricing ranges from $33.95 to $44.95 depending on quantity; please see the
"PURCHASING" tab on the website for pricing)

Pros: "Plug 'n play," basket to center scan sheets under the camera, created with educator input,
cost

Cons: Manual focus

Note: If you have to install software with your camera, it might not work for GradeCam.

What's next?

Once you have picked a camera that is compatible with GradeCam, you can start scanning!
Please view our "Scanning" help document for quick tips on scanning.
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